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1 INTRODUCTION
1.1 WHAT IS IPVS_CHARTS?

The Integrated Portable Visualization System (IPVS) was designed to provide the COAMPS-OS
user with graphical data products that can be viewed from any computer platform using a web
browser. The IPVS web page contains a standard set of weather products organized in tabular
pages generated for each model area defined by the COAMPS-OS user. IPVS CHARTS allows
the COAMPS-OS user to create custom weather products, which can be added to the IPVS web

page.

IPVS CHARTS is a tool designed for the weather forecaster and briefer. It gives the
forecasterand briefer a means to create weather charts to aid in the forecasting process and to
produceprofessional briefings.

IPVS _CHARTS is a unique data viewer because it accesses a four dimensional block of weather
model data. Most data viewers are restricted to two- or three-dimensional data. For example,
they might provide a two-dimensional map view with the ability to animate the map over time,
thus providing a third dimension. IPVS CHARTS, on the other hand, has four dimensions that
may be selected from: longitude, latitude, level and time. Two of these may be selected to create
a two-dimensional map view that can be animated over either of the two remaining dimensions.

IPVS _CHARTS allows a map view to be animated in time or level. There are many possibilities
for both static and animated views. A longitude slice, defined at a specific latitude, plotted with a
selected level (vertical cross-section) can be animated in latitude or time. A latitude slice, defined
at a specific longitude, plotted with a selected level can be animated in time or longitude.
Selected time sections may be plotted with any of the other three dimensions to produce useful
combinations, such as: 1) a selected level range to be animated over latitude or longitude, 2) a
latitude range to be animated over level or longitude, or 3) a longitude range to be animated over
level or latitude. In addition to orthogonal slices along longitude and latitude lines, vertical slices
along an arbitrary path can be animated over time.

This capability to animate, or loop, on one dimension while two others are fixed provides the
user with the ability to scan the four dimensional block of data in a wide variety of ways. Using
this feature makes IPVS CHARTS both a data viewer and a data scanner, which allows you to
quickly spot forecast trends and key weather features. Weather data can be scanned by viewing
data series using either of two methods: 1) automatically generated for the IPVS web page or
2) interactively using IPVS_CHARTS directly.

In short, IPVS CHARTS removes much of the drudgery involved in preparing forecasts and
briefs, which allows you to concentrate your time on making the best possible forecasts.
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1.2 WHAT IS A CHART?

A chart is a two-dimensional representation of a data set from a numerical weather model, such
as COAMPS run by COAMPS-OS or NOGAPS run at Fleet Numerical Meteorology and
Oceanography Center (FNMOC). A chart may be a horizontal map view, a vertical profile at a
point, or a vertical cross-section along a latitude or longitude line. Figure 1 below depicts a
typical horizontal chart.
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Figure 1. Typical horizontal chart.

Each chart has explicit labeling conventions that identify the data it represents. For example,
Figure 1 represents the COAMPS model master grids of geopotential height at 500 millibars and
relative vorticity and winds. This particular chart is an analysis that is valid for 12:00Z on 10
June 2003. A chart may be an analysis, which is based upon observation (NOGAPS) data at
TAU 0. Alternatively it may represent a prognosis, which is based upon forecast (COAMPS)
data. Different colors and/or line types indicate the different fields in a chart when multiple
parameters are plotted.
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Figure 1 shows scalar data, which are magnitudes with no associated direction (e.g.,
temperatures, pressures, and geopotential heights). This chart also depicts vector data, which
have both magnitude and direction (e.g., winds and currents). Vector data is displayed in one of
three ways. The first option is wind barbs, indicating magnitude by the number of barbs showing
wind velocity. The second option is arrows, where the length of the arrows indicates magnitude.
The third option is streamlines, which only show the direction of flow. Vector data and scalar
data may be displayed on the same chart.

You can use IPVS CHARTS to create single charts and/or sequences of charts. If you wish to
create a time series, only one chart must be defined. [IPVS CHARTS will automatically create
the other charts of the sequence. At this time, the IPVS web page only supports time sequences.

1.3 GETTING STARTED

Before using [IPVS CHARTS, there are a several configuration steps that you must execute on
your PC in order to achieve proper viewing of the IPVS CHARTS GUI.

First, close any xterms you have open and exit all applications that you may be running. Use the
Settings Control Panel icon to access the Display icon. Adjust the Color Palette on the Settings
Tab to 256 colors. Then follow the instructions below according to the X Windows server that
you are running.

Configuration steps for IPVS CHARTS using Reflection X:

1. TUNER:

Open the Reflection X server. On the “X Client Manager” toolbar under the “Tools” menu,
select “Performance Tuner”. On the “Performance Tuner” in the “Test Categories” box click on
“Select All”. Next click the “Run” button. Once the process has begun, do not move your mouse
or do any keyboard entries until the tuner has completed the task. The process will take about
three to five minutes.

2. FONTS:

At this time, you can also configure Reflection X to meet the font requirements for
IPVS _CHARTS. In the “X Client Manager” under the “Setting” menu, select “Fonts”. Scroll the
“Category” window on the left until the “Fonts” icon is visible. Under “Options” click on both
“Use fonts in X format from font server” and “Allow font scaling”.

3. SECURITY:

Finally, select “Security” under the “Settings” menu in the “X Client Manager”. Click on the
“Security” icon, then click the “Edit” button. Scroll to the bottom of the list and add the IP
address of the COAMPS-OS web server. Under the “File” menu select “Save”, then select
“Exit”.
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Configuration steps for IPVS_CHARTS using Hummingbird Exceed:

1. TUNER:

From the Exceed menu select “Xconfig” and double-click on the “Performance” icon. In the
“Performance” window, click on “Tune” and on the tuner window click on “Run All”. Once the
process has begun do not move the mouse or do any keyboard entries until the tuner has
completed the task. The process will take about three to five minutes.

2. FONTS:

Under the “Xconfig” menu, click the “Font” icon. Click the “Font Database” Then select “Font
DB File 75dpi”. Scroll down and verify that “adobe helvetica medium and bold fonts are
present”. If this is not the case, check the Exceed software instructions and install new fonts.
Otherwise, click OK in the “Font List” window then OK in the “Font Database” window.

3. SECURITY:

Under the “Xconfig” menu, click on the “Security” icon. Click on the “Edit” button in the “Host
Access Control List” area. Scroll to the bottom of the list and add the IP address of the
COAMPS-0OS web server. Under the “File” menu, select “Save” then select “Exit”.
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2 USING IPVS_CHARTS
2.1 MAKE A CHART

A chart is a two-dimensional representation of weather data produced from the model output of
COAMPS-OS, or similar source. IPVS CHARTS is used to create charts that present the data in
a graphical form.

The steps for creating a chart are as follows:

1. Launch IPVS CHARTS by selecting IPVS CHARTS from the Applications menu on the
COAMPS-OS home page.

/2 COAMPS-05(TM) Homepage - Linux Cluster @ NRL-MMD, Monterey, CA - Microsoft Internet Explorer =1 =10l x]
Fle Edt vew Favortes Took meb [ = |
GBack + = - @) (3] A | @Qieach [GFavortes @Meda (B | By S =1 5

Address Iijht nrimey . navy . mil COAMPSOS-binf COAMPSOS_homepage.cgi ;j e ‘Llnks 3

THIS IS AN OFFICIAL UNITED STATES NAVY WEB SITE

Naval Research Laboratory - Monterey
Marine Meteorology Division (Code 7500)

COAMPS-OS™

On-scene numerical weather
prediction by the Naval
Research Laboratory

Linux Cluster @ NRL-MMD, Monterey, CA
A a

€] hitp:fhail.nelmrynavy. milfCOAMPSOS-bin{COWEE_pp_ipvs_wrapper.tcl [ | 4 meemet

R

Figure 2. Access IPVS CHARTS from Applications link on COAMPS-OS home page
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IPVS CHARTS is password protected and prompts for a valid user and password (Figure 3).

Enter Network Password e

Please type pour uger name and password.

Site: hail. rirlrrr. nasey. il

Realm COAMPS-05[tm](Thiz iz a Department of
Defenze Computer System. This computer
zyztem, including all related equipment,
network s, and netwark. devices [specifically
including Intermet accessz] are provided only
far autharized 5. Government uze. DoD
Computer sy

Uzer Mame Icoamps

Password I “““““““ q

[ Save this pazzword in vour password list

] I Cancel |

Figure 3. Security Dialog for IPVS CHARTS

IPVS CHARTS prompts you to select a data set by presenting you with a File Selection
dialog (Figure 4).

»¢ Select ¥1S-Chart Files o =]
Available Project Chart Files
Project |Hest | Time A1
Califomia_15km 1 2003062512
California_15km 2 2003062512
HOA_5km 1 2003052000
HOA_5km 2 2003052000
HOA_5km 3 2003052000
SanDiego_3 1 2003061012
SanDiego_3 2 2003061012
SanDiego_3 3 2003061012
/
P =
4
I~ |~
Select it Help

Figure 4. The File Selection Dialog for IPVS CHARTS

This File Selection dialog presents all of the available files, stored under the user’s IPVS
directory structure for COAMPS-OS, for all of current model areas. The files are listed
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according to model area, grid geometry (e.g., nest 1 or 2) and base time with the format
YYYYMMDD<00 or 12> (e.g. 2003062512 would be the data set for 12Z on 25 June 2003).
Scroll down to the file for the desired model area, nest and base time.

4. Once you have found the desired file, click on the file line to display the file information.
Click “Select” to launch IPVS CHARTS with the file you have highlighted (Figure 5).

% Select ¥I5-Chart Files - 10| x|
Available Project Chart Files
Project 'Hest | Time EY
Califormia_15km 1 2003062512
California_15km 2 2003062312
HOA 5km 1 2003052000
HOA_5km 2 2003052000
HOA_5km 3 2003052000
SanDiego_3 |1 |2I]I]3I]B1 mez
SanDiego_3 P 20030612
SanDiego_3 3 20030612
{
P~ |-
Froject SanDiego_3

Mest: 1
Analysis Time: Tue Jun 10 12:00:00 GWT 2003

[

Level: Pressure Surface
##R#% Defined Fields #4##

=wenana= Yertical Yy-Yelocity Component (mis)
<t> Air Temperature (deg_K)
=dptd=> Dewpoint Depression (deq k)
=z= Geopotential Height (gpm)
<=ugrd= Grid LU-Velocity Component (mi's)
=vgrd= Grid YW-vVelocity Component (mis)
<relh= Relative Humidity (percent)
=y True U-Velocity Component (mi's)

N Sy g WP, U b W JUR DANpRr PO g S N S ARy g | f

Select Ciuit Help

Figure 5. Data files for IPVS_CHARTS are listed for the user's IPVS directory
5. By default, IPVS CHARTS displays a plot of surface pressure analysis overlaid on a map

representing the selected data file. IPVS _CHARTS has two screen modes: Standard and
Advanced. An example of the Advanced mode is shown in Figure 6 below.
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Figure 6. An example of an initial IPVS_CHARTS screen in Advanced Mode

6. Use the IPVS CHARTS controls to create the chart or sequence of charts desired. The
IPVS CHARTS section gives complete details on how to use the controls. Note: by selecting
latitude, longitude, and level ranges, you can influence the type of chart produced (horizontal
map, vertical profile, or vertical cross-section).

7. You have two options for storing your work. Save the chart product you have created to
allow the COAMPS-OS system to automatically generate new charts each time new data are
received. The second option is to save the images you created during this IPVS CHARTS
session. This option provides you with snapshots of your creations. It does not save the
definitions from which they were created nor does it result in the automatic generation of
updates. The subparagraphs below describe how to perform each type of save.

a. Saving Chart Definitions in the Automation List. When you add a chart definition to
the automation list, the computer will use the definition to generate a new set of chart
images each time new data are received. If you use the same series of charts each day for
a brief, you would want to use this option to ensure that you have a fresh set of charts
each day, based upon the latest data. To add a chart to the automation list, pull down the
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Automate menu, then select Save Product or Save Product As from the drop-down
menu. Save Product is used to save a file that has been saved before. If you select Save
Product the first time a products is saved, [IPVS CHARTS will suggest what to name the
chart, and it will present a confirmation dialog (Figure 7), which shows the chart name.
Click on the Accept button to accept the chart name and proceed with the save. After the
automation is saved, the computer will generate new images (e.g., as PNGs) in each
update cycle and add them to the image database.

If you select Save Product for a single image that has not been previously
& saved, IPVS_CHARTS will actually do a Save Product As.

»¢ Title a ¥IS-Chart Product . o [=]

Mo Chart Titles are in Use

Status | Project |Hest | Title

=

-

I~ | b

|Sea Level Pressure

~ [

Accept it Help

Figure 7. The Accept Confirmation dialog for Save Product option under the
Automate menu.

If you select the Save Product As option, the same Accept Confirmation dialog (Figure
8) appears. You can use this dialog to enter your own chart name for the automation, or
to select and edit an existing chart name. Note: if you select an existing name, more than
one chart will have the same name in the web page. This is not advised since only the
name distiguishes each chart in the image table.
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b.

»¢ Title a ¥I5-Chart Product =10] x|
Project Chart Titles Already in Use

Status | Project |Hest | Title 21
on California_15km 2 B25mhb to 10mb Profile Air Tempe
on California_15km Z 1013mb Relative Humidity/ Air Te
on California_15km Z2 1013mb to 10mb Z- Lon- Section |
on California_15km 2 1013mb to 10mb Z- Lat- Section |
on California_15km 2 1013mb to 10mb Z-Time - Section
on California_135kim Z 101 3mb to 10mb Profile Air Temp
on California_15kim Z "Sea Level Pressures (1000-500)r
on Califoria_15km 2 “Terrain Pressure’
on California_15km 2 "Sea Surface Temperature’
on California_15km Z2 "Visibility’ _.f
P | =

'Sea Level Pressure

P [

Accept Quit Help

Figure 8. The Save File dialog for Add Product As option under the Automate

menu.

Save Chart Images There are two options for saving images, Save Image and Save
Image As. Save Image is used to save a file that has been saved before, or to save a set
of images (e.g., a time sequence). Save Image stores the file under the existing name. In
the case of a sequence, it will be saved as an automatically generated name. After this
selection has been made a dialog appears (Figure 9) confirming the file name or, in the
case of a sequence, the file name of the first file in the sequence. Select OK to execute

the save action.

If you select Save Image for a single image that has not been previously saved,
& IPVS_CHARTS will actually do a Save Image As.

—

Figure 9. The Confirmation dialog for Save Image option under the File menu.

—

Save Image As is used to save a file for the first time, save a copy under a different
name, or to change the image format used. When you select Save Image As, a Save As
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dialog will appear (Figure 10). To save the file under the default file name and using the
default image format, simply click the Save button.

A custom file name and type may also be selected. The File name field allows you to
enter the desired file name. When the dialog first appears, the default file name is
displayed. To change the file name, click in the field and type the name you desire. The
Files of type field lists available image formats that may be used for the file. The image
format types include PNG (default, .png) and GIF (.gif). To select a type, simply add a
period and the desired extension for image format after your file name in the File Name
field. These formats can be used to export images into other programs (e.g., PowerPoint).
Click Save to close the dialog and save the file under the name shown.

The names of images and any corresponding automation files are linked for easy
recognition and future re-editing whenever Save Image As or Save Product As are used.

¥ Save As =101 x|
Directory: fCOAMPS0S-D/pubhtmlicoamps/iSanDiego_3fimages — | |

El Img.SanDiego_3.91.qif
El Img.SanDiego_3.g2.qif
El Img.SanDiego_3.93.qif
El Map.Sanbiego_3.91.png
El Map.Sanbiego_3.9&.png
El Map. Sanbiego_3.93.png

P~ [
File nhame: ISanDiegn_SJ.slprD.pnd | Save |
Files of type: Image Files {*.gif,”.pni) — | Cancel |

Figure 10. The Save As dialog for Save Image As option under the File menu.

2.2 CREATE A SERIES OF CHARTS

The IPVS CHARTS gives you the tools to automatically create a time-sequence animation from
a single chart display. You create the chart once, and IPVS CHARTS will automatically produce
a chart with the same data for the range of the forecast times you select. The typical
IPVS CHARTS screen for the Advanced mode is shown in Figure 6.

Instructions for using the IPVS_CHARTS controls in both the Advanced and Standard modes
can be found in Section 3. This section describes, in further detail, instructions for setting up
your first chart. This may be a map-style chart, a vertical profile, or a vertical cross-section.

To create a time series of charts, follow the steps below.
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1. Select a range of times on the time line at the right side of the chart (Figure 11).

Provided
1 hr

1202 - 10 AN
2

14 JUH
2003

Figure 11. The time line editor tool.

2. Use the middle mouse button to select the first and last points. The range between those two
points will be filled in automatically. The selected time range will be highlighted in red. You
can also select the time interval between charts by either increasing or decreasing the interval
by clicking the < or > buttons.

3. Click the Animate button and the animation will be produced. Alternatively, you can pull
down the File menu and select Save Image or Save Image As.

& Middle mouse click on the animation to stop cycling of images.

As the animation is generated, each slide will be displayed briefly. If you selected Save
Image, the animation is saved with a generic name and a confirmation dialog is displayed to
allow you to confirm the default file name. If you selected Save Image As, a file selection
dialog is displayed to let you enter your own file name or select one previously used. If you
select a previously used file name, that file series will be overwritten with the new data.
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3 EDIT A CHART

IPVS CHARTS (Figure 6) produces two-dimensional charts based upon gridded data fields
produced by computer weather models. These can be horizontal map views at the surface or a
selected pressure level, or they can be vertical cross-sections along latitude or longitude lines or
arbitrary paths. Scalar data can be shown as line contours, color-filled contours, or block shaded
(i.e., displayed as color filled grids). Vector data can be plotted as barbs, vector arrows, or
streamlines. You can easily select the desired values, or ranges, of longitude, latitude, height (in
altitude or pressure coordinates), and time to display a single plot, or a sequence of plots. You
can plot one or more variables simply by clicking on variable type buttons. You can also
customize the way each variable is plotted. A single plot or sequence of plots can be accessed in
a number of ways: 1) saved into the /mages directory, 2) plotted to a local printer, or 3) placed
on the IPVS web page to be automatically updated at the end of each COAMPS-OS cycle.

When you launch IPVS CHARTS, a file selection dialog is displayed allowing you to select a
set of grid data to be used for the charts. Refer to Section 2 of this document for instructions on
getting started.

At any time you wish to redisplay the chart, you can force this action by clicking on the

& “Draw” button in the upper right corner of the main IPVS_CHARTS screen. A right
mouse click on the “Draw” button forces a full redraw when portions of the display
have been obscured by other windows covering the IPVS_CHARTS screen

3.1 USING THE EDITOR TOOLS

IPVS _CHARTS has two screen modes: Advanced and Standard. The Advanced mode shows the
the time selection bar (Figure 11), dimension selector buttons and bars (Figure 12), and panels of
parameter toggle buttons (Figure 13). These are convenient for quickly changing dimensions
and parameters, but can be confusing for a new user. The Standard mode eliminates these
providing a simple, clean map view of the data. Parameter and level selections (i.e., pressure
levels or height surfaces) are made using Data and Level menus.

3.1.1 Advanced Mode

The Advanced mode relies on time and dimension selector bars to set lattitude, longitude, level
and time and display an appropriate chart. Table 1 below describes the chart that will be inferred
and displayed for every combination of selector settings. The results range from tabulated data
to line plots to map plots to animations. The convenient access to dimensions and parameters
allows the user to quickly scan through many options and conditions to track and diagnose data
issues.

a. Time Selector (Figure 11): Select the time span for the data set using the time scale on the
right side of the IPVS CHARTS screen. To select a single time, click on the appropriate
point on the scale. To select a range of times, middle-click on the first time in the range and
middle-click again on the last time in the range. By selecting a range of times, a series of
images will be generated that can be animated.
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The arrow buttons (< and >), located at the top of the time scale, allow you to change the
interval between ticks on the time scale. The time interpolation interval determines the
number of interim charts that are computed and displayed between data times. For example,
if you have data for 00Z and 12Z, a 2-hour interpolation interval means that there will be five
intermediate charts labelled “Interpolated” and shown in an animation of the data. The
interim charts are linearly interpolated in time between the data times. The smaller the time
interpolation interval, the smoother your animation will be, but the more hard drive space it
will occupy on your computer.

The IPVS web page automatically displays time sequences only at the model forecast
times. Time settings only affect session animations.

b. Latitude/Longitude/Level Selector (Figure 12): The Longitude, Latitude, and Level
buttons toggle the scale between longitude, latitude, and level selection, respectively. These
selectors allow you to create a variety of animations or static displays. Select a single value
of the active parameter by clicking on the appropriate point on the scale. Select a range of
values by clicking with the middle mouse button on the first value in the range. Then click
with the middle mouse button on the last value in the range. If you select a single latitude and
longitude and a range of levels, the end product will be a vertical profile of the selected
parameter(s) at that point. If you select a single latitude, a range of longitudes, and a range of
levels, you will see a vertical cross-section along the selected latitude between the selected
longitude limits. If you select a single longitude, a range of latitudes and a range of levels,
you will see a vertical cross-section along the selected longitude line between the selected
latitudes.

You can select the entire range of Latitude, Longitude or Level by double clicking with
& the left mouse button on the Selector bar when the desired dimension is activated.

Static cross-sections, or one-dimensional animations, will be generated based upon your
latitude, longitude or level selection. If a single latitude, longitude, or level value is selected,
a static display will be created. If a range is displayed on the Selector, animation is produced.
The Draw/Animate button confirms the impending action.
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Longitude
Latitude

1013

Figure 12. The latitude, longitude and level selector tool. Level is active.

The type of chart that is displayed is dependent upon the selections you have made for time,
longitude, latitude and level. As well, the chart displayed is dependent upon which of the
latitude/longitude/level buttons is activated.

? Each time you activate a new dimension button, you must click Draw/Animate to update the

chart.

When IPVS CHARTS is initially launched the entire range for Latitude and Longitude, the
base time for Time, and the surface Level are the default selections. Level is the activated
dimension by default. Additional possible scenarios are shown in the table below.
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Table 1. Possible chart displays with associated dimension settings.

LONGITUDE (X) | LATITUDE (Y) LEVEL (Z) | TIME (T) ACTIVATED RESULT
DIMENSION
Fixed Fixed Fixed Fixed Any Printed values
Fixed Fixed Fixed Varying Any Time line
Varying Fixed Fixed Fixed Any Line plot vs. X
Varying Fixed Fixed Varying X X-T section
T animated line plot vs X
T animated line plot vs X
Fixed Varying Fixed Fixed Any Line plot vs Y
Fixed Varying Fixed Varying X T animated line plot vs Y
Y Y-T section
z T animated line plot vs Y
Varying Varying Fixed Fixed X Line plot vs Y animated in X
Y Line plot vs X animated in Y
VA X-Y map
Varying Varying Fixed Varying X Y-T section animated in X
Y X-T section animated in Y
4 X-Y map animated in T
Fixed Fixed Varying Fixed Any Z vs variable
Fixed Fixed Varying Varying X T animated Z vs variable
Y T animated Z vs variable
4 Z-T section
Varying Fixed Varying Fixed X Z vs variable animated in X
Y Z-X section
4 Z-T section
Varying Fixed Varying Varying X Z-T section animated in X
Y Z-X section animated in T
4 Z-T section animated in Z
Fixed Varying Varying Fixed X Z-Y section
Y Z vs variable animated in Y
4 Line vs Y animated in Z
Fixed Varying Varying Varying X Z-Y section animated in T
Y Z-T section animated in Y
4 Y-T section animated in Z
Varying Varying Varying Fixed X Z-Y section animated in X
Y Z-X section animated in Y
z X-Y map animated in Z
Varying Varying Varying Varying Any Prohibited
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C.

Parameter Buttons (Figure 13): In the IPVS_CHARTS screen above the chart display area
are the parameter buttons, representing the available parameters for the selected data set.
Click on a parameter using the left mouse button to add the parameter to the display. You
may display multiple parameters simultaneously by clicking the button for each parameter
you desire.

I Pressure Data File
Filé 1 of 2 wwww L dptd oz ougrd | ward | relh | u
v | ryar | abhu | pott d_ptt wepd | wind
shac | prcp | chas | ceil | ctop | ctpt | tigg

Fel=Ts tsea | topo | wish | tepr | strs thek

Figure 13. Sample view of parameter buttons located at the top of the
IPVS_CHARTS screen in Advanced mode.

Examples of the parameters currently available for display are:

e slpr Surface pressure e 7 Geopotential height

e t Temperature e dptt Dew point temperature

e wspd Wind speed e wind Wind speed and direction

e u U-Velocity Component ¢ relh Relative humidity

e v V-Velocity Component e divg Divergence

e avor Absolute vorticity e thck 1000-500 millibar thickness

The Pressure Data File shown in Figure 13 is one of two files opened simultaneously when a
project and date group are selected. The second file is for Height surface data . By clicking
on the right (>) arrow the parameter buttons will be displayed for the available Height data
and the Level selector (Figure 12) will convert to height surface values. Any combination of
Pressure and Height parameters can be selected and displayed.

Note: For additional model parameters refer to the COAMPS-OS home page. On this web
page you will find a Parameter Descriptions link that includes a complete list of parameters
with the full name name, abbreviation, and additional information.

Adjusting the Display for a Data Type: Right-click on a parameter button to invoke the
Parameter Options dialog (Figure 14). The activated components of this dialog are
dependent upon the selected data type. Additional information on this editor tool is provided
in Section 3.3 Customizing Data Plots.
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X GFADS 1.85L11 L =10 %]
Saelact options for slpr Source Units mb
MSL Sea Level Pressure Display Units mb =
Default Scalar Plot Settings EHEEN T [ [

Type Contour Lines Interyal < < b
Shaded Contours M as i celia | 124 | =ins
Celorlegend D Caution ~w << < 1980 > 3>

N-::-n_e Bar Arc [

: E ‘warning = << < 12820 > 3>
Calors « | Options -

Default Vector Plot Settings

Default Line Plot Settings

Style Salid Marker Mane Cross
Dotted :
Dpen Dot Solid Dot
Lang Dash
Shaort Dash Cpen Box Solid Box
Help (] Cancel

Figure 14. Typical Parameter Options dialog view.

e. Draw: The currently selected data is displayed in the center of the screen. You can update
the display (for example, after changing a parameter display setting) by clicking the Draw
button. If you have selected a range of times, this will change the Draw button to an
Animate button, and cause a plot to be displayed for each selected time. Whenever a range
of values is selected on the left dimension bar, animation will result for that dimension. The
Draw/Animate button always announces the impending action.

3.1.2 Standard Mode

The Standard mode (Figure 15) relies on dropdown menus to select data and their pressure or
height level. Latitude and longitude are fixed to the full extent of the data files for the selected
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project and subgrid nest. The session time is fixed to the analysis time (i.e., tau=0). The
simplified map view allows the user to quickly compose typical charts that are most frequently
needed. The Standard mode does not allow scanning data in any dimension or in time.

Simplified methods for creating and viewing arbitrary cross-section and profile plots are
available (Figure 26).

xoosiosii =lo/x
File ot Automate Mode View Cptions Data Level Setting Help Draw |
UNCLASSIFIED

NRL COAMPS—0%" Sanliege 3 B3.0km 7=0 h
Bazelime: 12Z10JUNZ003 Verify: Tue 12:007 10 JUN 2003

f‘ 1028
(s
/
40K - i
h/J 1024
b
1020
o
5
3
35K - 1016E
=
%
e |
A 112
oM - 1008
1004
1000
135 130W 129w 120W

MSL Sea Lewel Fressure (mhb) B

UNCLASSIFIED

Figure 15. An example of an initial IPVS_CHARTS screen in Standard mode.
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a. Data Menus (Figure 16): The Pressure Level, Height Level, and Surface data are listed in
separate submenus and data categories to aid locating the many parameters that can be
requested of the model.

Data Level Setting Help

Pressure Level Height

Height Level Temperature

Surfaces Maisture
Wwind

Data Level Setting Help

Pressure Level

Height Level Temperature
Surfaces M aisture
Wind

Refractivity

Datal Level Setting Help

Pressure Level

Height Level

Surfaces Pressure
Height
Claud

Precipitation
Concentration
Surface
Ocean

Surface Physics

Figure 16. Data selection menus for Standard mode.
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b. Data Selection (Figure 17): Table 2 lists all possible COAMPS-OS model parameters by
their data category which defines where they will appear in the Data menus. Parameter
selections are indicated with an asterisk. Selecting a marked item de-selects that item.

Data Level Setting Help

Pressure Level Height

Height Level Temperature 212 fir Temperature

Surfaces - Muoisture <pott> Potential Temperature
Ww'ind

Figure 17. An example of parameter selection in Standard mode.

c. Data Levels (Figure 18): Parameters selected with the Data menu automatically appear in
the Level_ menu to allow level selection for upper level variables. Level selections are
indicated with an asterisk. Selecting a marked level de-selects that level.

Level | Setting Help

| <t> &ir Temperature; pressure 1013=500 mb 1013

LAt &ir Temperature: pressure 400-10 mb 1000

"2slpr> Sea Level Pressure: surface level 975
350
925
300
850
200
Foo0
S00

Figure 18. An example of Level selection in Standard mode.
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Table 2. Data Categories for Standard Mode Data Menus

Pressure
slpr = Sea Level Pressure

slpr2 = Sea Level Pressure

perp = Pressure Perturbation

tepr = Terraln Pressure

trpr = Tropopause Pressure

pppp = Total Pressure

Height

z = Geopotential Height

dval = Geopotential Height

thck = 500mB-1000mB Height Thickness
geop = Geopotential Dynamic Height (m"2/s"2)
blht = Planetary Boundary Layer Height
frzl = Freezing Level Above Ground Surface
topo = Terrain Height

Temperature

t = Alr Temperature

tttt = Air Temperature .

potp = Perturbation Potential Temperature
pott = Potential Temperature

Moisture L

abhu = Absolute Humidity

absh = Absolute Humidity

dptd = Dewpoint Depression

dptt = Dewpoint Temperature

relh = Relative Humidity

wvap = Water Vapor Mixing Ratio

vapr = Water Vapor Pressure

Wind

ugrd = Grid U-Velocity Component

vgrd = Grid V-Velocity Component

uuuu = Grid U-Velocity Component

vvvv = Grid V-Velocity Component

wwww = Vertical W-Velocity Component

u = True U-Velocity Component

v = True V-Velocity Component

utru = True U-Velocity Component

vtru = True V-Velocity Component

wspd = Wind Speed

wind = Vector wind

mxsp = Maximum Wind Speed

avor = Absolute Vorticity

rvor = Relative Vorticity

divv = Divergence

divg = Divergence

Refractivity

evdh = Evaporative Duct Height

mmmm = Modified Refractivity

dmdz = Modified Refractivity Gradient
ocht = Optimum Coupling Height

nnnn = Refractivity

Cloud

cbas = Cloud Base Height

cbrh = Cloud Base Height Using RH Threshold
ceil = Cloud Ceiling Height

ctop = Cloud Top Height

ctrh = Cloud Top Height Using RH Threshold
ctpt = Cloud Top Temperature

ctpr = Cloud Top Temp Using RH Threshold
ccvr = Total Cloud Coverage Using RH Threshold
gccc = Cloud Mixing Ratio

giii = Ice Mixing Ratio

grrr = Rain Mixing Ratio

gsss = Snow Mixing Ratio .

wvap = Water Vapor Mixing Ratio
Precipitation

cpac = Accumulated Convective Precipitation
conp = Bucket Convective Precipitation
spac = Accumulated Stable Precipitation
stap = Bucket Stable Precipitation
tpac = Accumulated Total Precipitation
prcp = Bucket Total Precipitation

ingv = Precipitable Water

snac = Accumulated Snow

snow = Bucket Snow

snwp = Snow Depth

(Mesinger Treadon method)

Heat

diab = Diabatic Heatin% Rate

evap = Evaporative Cooling Rate

heat = Heat Index

rhtr = Radiative Heating Rate (deg K/s)
lrad = Long Wave Radiation -
hfll = Latent Heat Flux

nrad = Net Radiation

hfls = Sensible Heat Flux

srad = Solar Radiation

trdn = Downward Total Radiation

trad = Radiative Heating Rate (watt/m"2)
csrc = Source Emission Strength
Concentration

arsl = Aerosol

cccc = Tracer Concentration

csum = Tracer Mass Dosage

visb = Visibility

Turbulence

brin = Bulk Richardson Number

eeee = Turbulent Kinetic Energy

tkee = Turbulent Kinetic Energy

khkh = Eddy Mixing Coefficient for Heat
kmkm = Eddy Mixing Coeff. for Momentum
ksks = Smagorinsky Mixing Coefficient
mxgl = Mixing Length

Surface

ttgg = Ground Sea Surface Temperature

temp = Surface Air Temperature

ugrds = Surface Grid U-Velocity Component
vgrds = Surface Grid V-Velocity Component
Ocean

odep = Ocean Depth

land = Land Sea Table

nice = NOGAPS Ice Coverage

icec = Sea Ice Coverage

htss = Altimeter Sea Surface Ht. Anomaly
tsea = Sea Surface Temperature

salt = Salinity

Surface Physics

albd = Albedo

soil = Deep Soil Temperature

g8ra = GOES 8 Brightness Temperature

g9ra = GOES 9 Brightness Temperature

tstr = Scale Temperature for the Surface
hflt = Surface Heat Flux

trads = Surface Radiative Heating Rate
z0z0 = Surface Roughness

gwet = Ground Wetness o
wvaps = Surface Water Vapor Mixing Ratio
vaprs = Surface Water Vapor Pressure

gstr = Scale Mixing Ratio for Surface
ustr = Scale Velocity for Surface Wind
strs = Wind Stress
wstr = Wind Stress vector

stru = Grid U-Component of Wind Stress
strv = Grid V-Component of Wind Stress
stut = True U-Component of Wind Stress
stvt = True V-Component of Wind Stress
Boundary

dpp = Boundary Perturbation Pressure
bdpr = Boundary Pressure
bdpt = Boundary Potential Temperature
bdtt = Boundary Temperature
bduu = Boundary Grid U-Velocity Component
bdvv = Boundary Grid V-Velocity Component
bdww = Boundary Grid W-Velocity Component
bdgv = Boundary Mixing Ratio

Increment

dinc = Geogotential Height Increment

stin = Analyzed Increment of Surface Temp
dpin = Dewpoint Depression Increment
uinc = Grid U-Velocity Increment
vinc = Grid V-Velocity Increment
Satellite
vis = Visible Channel

ir = Infa-Red Channel
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3.2 THE IPVS _CHARTS MENUS

To navigate through a menu’s options, hold the left button down to scroll through menu and sub-
menu options. Release the button and click on the option to make your selection. If you do not
wish to select any of the displayed options, click anywhere on the screen to close the menu and
start over. Alternatively to have menus stick, click the left button on a menu header to popup its
submenu and repeat with single clicks on each submenu selection.

For all IPVS CHARTS menus, a triangle (arrow) next to a label or field indicates a drop down
menu with additional options. An asterisk next to an option indicates the current selection.

1. File Menu

File

Cpen Grid

S5ave |mage

Save lmage &s
Yiew Saved lmage
Print

it
Figure 19. File menu options.

a. Open Grid: Allows you to select a new data set for display. If there is a data set currently
displayed, it will be closed before opening the new one.

b. Save Image: Saves the current screen image in the current format (e.g., PNG which is the
default) with a file name created by IPVS CHARTS. If you have previously used Save
Image As during the current session, the screen image will be saved with the image type
and file name that you specified.

c. Save Image As: Allows you to save the current screen image as a GIF or PNG file type.
The Save Image As option opens a Save File dialog that allows you to specify a file
name or select an existing file name. If you select an existing file name, the data in that
file will be overwritten by the new data. Note: using this option will set the file name
base and file type for the remainder of the current session.

d. View Saved Image: Allows you to view previously saved images. Images are viewed
with the browser and may be printed or mailed electronically.

e. Print: Prints the current screen display to the default UNIX printer configured for the
UNIX “Ip” command. If you wish to use a different printer, your UNIX System
Administrator must set the LPDEST environment variable to the new printer destination.

Page 23 July 2003



IPVS_CHARTS User's Guide

There are two methods for printing a chart from the IPVS web page using a PC.

& These methods ensure that the chart fits on one 8 1/2 X 11” piece of paper. 1)
Select Page Setup under the File menu in your browser. Set the left and right
margins to 0”. Then select Print. 2) Select Print under the File menu. Select
Properties from the Print dialog box. Set the output format to /Jandscape to rotate
the figure. Then select OK.

f.  Quit: Closes the IPVS CHARTS Editor, automatically saving the current settings into a
user profile.

You should always close the IPVS_CHARTS Editor by using the Quit option on

& the File menu rather than by using the Close option on the window’s command
menu. This will ensure that the user profile data needed for the next session are
always saved. Each new session will start up in the configuration used when the
last session was closed.

2. Edit Menu (Figure 20): is only available when Section or Profile Mode have been selected
and cross-section or profile points have been identified.

Edit

Delete all
Move Points
Delete Points
Maove Route
Delete Route

Insert Route Point
Figure 20. Edit menu options.
a. Delete All: Deletes all section and profile points.

b. Move Points: Allows you to select and place section or profile points at new locations.
Moved points can be reselected and moved until the current edit session has ended.

c. Delete Points: Allows you to select/deselect and then delete section and profile points.
Points can be selected, deselected and reselected until the current edit session has ended.

d. Delete Path: Allows you to select/deselect and then delete a section path.

e. Move Path: Allows you to select a section path and place the path at a new location. The
first point picked becomes a reference point for the move. The next mouse click selection
sets the new position for the first point and defines the vector used to move the entire
path.

f. Insert Path Point: Adds a new point to an existing path segment where you have clicked.
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3. Automate Menu

a.

Automate

Save Product

Save Product fs
Cpen a Product
Delete Products
Manage Web Products
Update Web Page

Figure 21. Automate menu options.

Save Product

Save Product fs Default
Cpen a Product SanDiego_3
Delete Products

Manage wWeb Products

Update Web Page

Save Product

Save Product fs

Cpen a Product Default

Delete Products SanDieqo_3
Manage Wehb Products fny Project
Update Web Page fn Example

Figure 22. Save Product As and Open a Product submenu options.

Save Product. Re-saves a product that was previously saved in the current session or if
an existing product has been opened and edited. If neither, Save Product defaults to
Save Product As. Creates a template of data definitions for the selected data, zoom
location, and plot ranges that were used to create the current chart. It then adds the
template and a custom product script to the automation list. Based upon the chart
definitions that you have established, a new set of images will automatically be generated
each update cycle and stored in the web page database.

Save Product As: When you choose Save Product As, a suggested chart name is
generated for the product. Before the operation is executed, a confirmation dialog will
appear with the suggested name of the chart (Figure 7). The dialog will provide you with
the option to proceed or cancel. However, instead of saving the file with the suggested
name, a text dialog appears (Figure 8) allowing you to enter a name or use an existing
name.
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The Save Product As dialog allows you to save products with the same name.
? However, it is recommended that you avoid this so charts can be easily identified
by their row title. If you select an existing file name, two (or more charts) will

appear with the same row name on the IPVS web page.

Products can be saved for the current project, e.g., SanDiego 3, or as a Default product
(Figure 21). Any products saved as a default product will be automatically applied to all

currently running projects and new projects subsequently created.

Open a Saved Product. Lets you open and reuse a previously saved project chart, a
default chart, or an example chart template. If the chart that you choose is for a different
project or data set than that which is currently displayed, IPVS CHARTS will attempt to
create the chart for the current area and data set. Note: this may not always work. The
requested parameters may not be available from the current data set or the geometry may

not translate.

Delete Products: Displays the list of chart files on the automation list. This option allows

you to delete a chart file so that it no longer generates automated updates.

-lo/
Available Project Chart Files to Delete
Status | Project Mest | Title X
on Default 1] "10m Wind Speed Colored Streamli
oh Default 0 '2a0mb Wind Speedf Winds’
on Default 1] *a00mb HeightfWind/Rel Vorticity’
oh Default 0 ‘6o0mb Alr Temperature/ Winds/ Gi
on |Default [0 |'925mb HeightA¥ind/Rel Humidity’
oh Default 1} "2m Air Temperature10m Wind/Se:
oh Default 0 "Sea Level Pressure/Accum Precip
on Default 0 *Sea Level Pressuref1000-500mb
¥
N i =
Project; Default I
Mest: O
Plot Times: One time at Tau O
Contents: '02Emb Height/wind/Rel Humidity
##i#t# Defined Fields ####
<telh= isbr_lvl 925
<windz ishr_lwl 925
<z ishr_Ivl 925
/
- |-

Select Ouit Help

Figure 23. An example view of available chart files that may be deleted.

Multiple charts can be selected using Left-Button-Click + Shift key to select a
range, or Left-Button-Click + Ctrl key to toggle individual selections.
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e. Manage Web Products: Allows products to be turned off or on without deleting them so
they are still available for future use. Multiple charts can be selected/de-selected similar
to deleting charts.

_Iofx]
Available Project Chart Files to Select
Status | Project Nest | Title X
on California_15km 2 1013mb Relative Humidityfwith S
on California_15km 2 "1013mhb Relative Humidityfwith P
California_15km 2 925mb to 10mb Z- Path- Section F
California_15km 2 925mb Lon-Time- Section Relativ
California_15km 2 J2amb Lat-Time- Section Relativi
California_15km 2 "825mb to 10mb Profile Air Tempet
on California_15km 2 "1013mb Relative Humidity/ Air Tel
on California_15km 2 1013mb to 10mb Z-Lon-3ection F
on California_15km 2 1013mb to 10mb Z-Lat-Section R
on California_15km 2 "1013mb to 10mb Z-Time- Section ]
L — ! ]
Project: California_15km I

MNest: 2

Plot Times: Every 60 mn from Tau © to 24

Contents: '925mb Lon-Time-5ection Relative Humidity’
#### Defined Fields &####

<relh> section 0

=~

Select Suit Help

Figure 24. An example view of turning off several charts.

f. Update Web Page: Allows the immediate, interactive update of additions, deletions, and
changes to automated images created for the web page and allows you to review the new
page. The web browser may require a reload, refresh, or exit/restart to display the
changes. All charts, customized since the last web page update, are updated when the first
request in a session is made to update the web page. This allows the IPVS CHARTS user
to perform several edit sessions before committing changes to an updated web page.

4. Mode Menu controls the type of chart displayed. The menu contents vary with the mode
selected (Standard or Advanced). Figure 25 below shows the Mode menu in Advanced
mode. Figure 26 shows the Mode menu in Standard mode.

In Advanced mode, the Same and Mixed Level modes allow the data to be viewed over an
area controlled by Longitude, Latitude and Level. The Sections and Profiles modes allow
the data to be viewed along an arbitrary section path or at selected points, respectively.
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Made

* Same Level
Mix Lewvels
Sections
Frofiles

Figure 25. Mode menu options in Advanced mode.

Same Level: Allows you to synchronize Level of all displayed multi-level (e.g., upper air
data) data to the same level. This facilitates the ability to recognize data correlation,
especially while animating in level. Data can be scanned in longitude, latitude, and level
by setting data ranges using the Longitude, Latitude, and Level buttons. Most
combinations can be scanned in Time.

. Mix Levels: Allows you to display different data from different levels (e.g. 200mb wind
and surface pressure) and/or the same data from different levels (e.g., 200mb wind and
500mb wind). Data scanning is limited because the levels are restricted.

Sections: Allows you to define arbitrary paths by clicking on the desired map points after
selecting the Path button. Selecting the Section button and clicking the Draw button lets
you draw a vertical cross section of any selected data, except in the case of surface and
single level variables.

. Profiles: Allows you to pick arbitrary points by clicking on the map at desired points of
interest after selecting the Point button. Selecting the Profile button and clicking the
Draw button lets you draw vertical profiles of any selected data.

Mode

= Map Wiew
Set Route
Wiew Section
Set Points

Yiew Profiles

Figure 26. Mode menu options in Standard mode.

Map View: Allows you to view data charts in map view. Data scanning in level or time
is not available.

Set Route: Allows you to insert an arbitrary route with the mouse cursor by clicking on
the map with the left mouse button.

View Sections: Allows you to view the arbitrary vertical cross section by clicking the
Draw button. Vertical cross sections can be viewed of any selected data, except in the
case of surface and single level variables.
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Set Points: Allows you to insert profile points with the mouse cursor by clicking on the
map with the left mouse button.

View Profiles: Allows you to view profiles at arbitrary points. Clicking the Draw button
lets you draw vertical profiles of any selected upper level data.

5. View Menu

11.

1il.

Wigw

Lacation

Grid Lines

Crid Pitch
Faolitical Bound,
Projection
Taopography
Labels

View Style

Figure 27. View menu options.

Location: Allows you to select the part of the map on which data will be plotted — over
land, over water, or both (default). This affects all of the selected data.

Grid Lines: Turns display of grid lines (latitude-longitude lines) on and off, and allows
you to select dotted or solid lines for the display.

Grid Pitch: 1f grid lines are turned on, allows you to select from a list of degree intervals
for the grid lines. There is also an auto grid pitch that will limit the number of intervals to
a maximum of ten along the longest dimension. The number of intervals will be updated
as the chart is zoomed or unzoomed.

Political Bound: Allows you to select whether or not to display political boundaries (i.e.,
outlines of countries and states). If you wish to display the boundaries, select thick or thin
according to the line size you desire. Otherwise, select Off.

Projection: Allows you to select the map projection used for viewing the data. The
options are:

None: No projection is used and scaling and accurate proportions are lost.
Lat-Long: Rectilinear (Cartesian) projection is used.

NPS: Polar Stereographic projection, centered at the North Pole, is used. Midlatitude
plots appear as a wedge.
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iv.  SPS: Polar Stereographic projection, centered at the South Pole, is used. Midlatitude
plots appear as a wedge.

f. Topography: Allows you to select how topography is displayed. The default is Filled,
which simply paints land and sea in different colors. The option Solid turns off land-sea
differentiation with a blue background. The Shaded option shows mountain ranges in
shaded relief. The Colored option shows color-coded altitude contours. The None option
lets the page background show through to simplify charts and printing.

g. Labels: Allows you to choose whether to display labels for the Title, Forecast Time,
Valid Time, Latitude and Longitude, Legends, and Frame.

h. View Style: Allows you to select between web page and standard view. The web page
differs from standard view in the title location and title contents. The web page view is
only available for horizontal map views. Vertical cross-sections along a latitude,
longitude or time only have the standard look available.
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Options
Menu Mode
Level Units
Site Lahels
Colors
Fonts
Text Size
Color Bars
Figure 28. Options menu options.

a. Menu Mode: Allows you to select between Advanced and Standard menu modes.

b. Level Units: Allows you to select the units for the vertical coordinate system. The
available unit choices are dependent upon the vertical coordinates (i.e., height or
pressure) of the available data.

c. Site Labels: Allows you to toggle on/off the display of location names for cities and
weather stations.

d. Colors: Provides options for selecting the colors for the following chart features:

1. Schemes: Allows you to set a coordinated set of background, label, and map colors at
once. This option has a built in restriction that prevents drawing white labels on a
white background.

1.  Background: Allows you to set the color of the page (area surrounding the map).
iii.  Titles: Allows you to set the color of the titles.
iv.  Labels: Allows you to set the color of the data labels.
v.  Axes: Allows you to set the color for plot axes.
vi.  Map: Allows you to set the color for map outlines and political boundaries.
vii.  Cities: Allows you to set the font of the city names (this option is only available if
Site labels has been turned on).
e. Fonts: Provides options for selecting the fonts used in the chart display. The selections

apply to all text on the image.
Normal (default): sans serif or Helvetica type font.

Bold: sans serif or Helvetica type font but in a heavier style than Normal.
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1.  Normal Roman: serif typeface.
iv.  Bold Roman: serif type face but heavier than Normal Roman.
v.  ltalic: slanted typeface.

f. Text Size: Provides the capability to modify text size for each of the following: Titles,
Legends, Symbols, Lat/Lon, and Cities. Each of these options has point size suboptions
for changing text size. Each click increases or decreases the text size by ten percent.

g. Color Bars: Provides the option for viewing multiple color bars combined into a single
column or separate side-by-side columns.

7. Help Menu Contains links to an on-line PDF version of this document.

Help

iy ary e
Contents

fbout Charts
Using IPYS_Charts
Editing a Chart
Chart Maodes
Possible Charts

Custamizing

Figure 29. Help menu options.

3.3 CUSTOMIZING DATA PLOTS

The Parameter Options dialog (Figure 14) allows you to set the display options for parameters.
To launch this dialog, right-click on the button (e.g., slpr) for the parameter you wish to edit.
The parameter abbreviation and long name will be displayed at the top of the dialog. Note:
Scalar Plot Settings or Vector Plot Settings will be activated according to the type of parameter
that you have selected for editing.

1. Units Settings

The Parameter Options dialog allows you to select the units that will be used to display the
data in the source file. The units provided in the current data file are shown in the upper right
corner in the Source Units field. To select different units, click in the Display Units field
then drag the mouse down to the desired units.

2. Scalar Plot Settings

The Scalar Plot Settings section allows you to select: 1) plot type, 2) color legend settings,
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3) interval settings, and 4) flag thresholds. These options are described below.

a. Plot Type: The three options for this setting are Contour Lines, Shaded Contours, and
Filled Grids. These three options are grouped as radio buttons, where only one can be
selected at a time.

i.  Contour Lines: displays only the lines marking the contour values. This selection is
preferable when you have multiple fields displayed.

ii.  Shaded Contours: displays contour lines and color-fills the areas between the
contours. This selection helps to quickly identify overall trends and features in a
single-parameter display.

iii.  Filled Grids: displays grid data as colored blocks of data at the resolution and the data
grid. This selection brings attention to the resolution of the underlying grid.

b. Color Legend Settings: Your legend options are as follows: 1) None, 2) Bar, or 3) Arc.
If you wish to have a legend, either bar or arc can be selected, not both. If you elect to
display a legend, you may further customize the legend appearance by selecting options
from available color schemes menu (Figure 30) and custom color editor (Figure 31).

The color schemes are self-explanatory and can be previewed before updating to the
display. After selecting a scheme, the color bar next to Scalar Plot Settings will display
the associated color sequence. Rainbow is the default color scheme for all parameters.

There are a couple of considerations associated with color selections to note. When
selecting Fade to Background, the topography option (under the View menu) must be
set to None.

Colors -
Cus.tomize
Custam
Single
* Sequence
Reverse Sequence
Fade to Background
Reverse Fade
Cycles

Reverse Cycles

Figure 30. Colors menu options in the Parameter Options dialog.

All color sequences and data levels are automatically created. Occasionally a unique
color sequence and data levels may be needed. By selecting Customize the color
pallette editor provides colors and data levels that can be edited. The initial colors and

Page 33 July 2003



IPVS_CHARTS User's Guide

level are those currently selected, so it is advised to approximate the desired custom
sequence as close as possible using the available color schemes and level adjustments.

The Custom color selection will present the custom colors and levels, if previously saved
for the displayed parameter.
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15
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Figure 31. Custom color editor in the Parameter Options dialog.

c. Labeling Options: Additional settings for legends are found under Options next to the
Colors menu. These are as follows:

1. Label Placement allows you to place labels only on horizontal sections of a contour,
or on all contours, even if they are vertical.

1.  Label Size allows you to increase or decrease the label text size.

iii.  Contour Units allows you to display the data units on contour labels just after the
contour value.

iv.  Black contours over shaded allows you to turn individual contour lines on or off.

Because of the limited number of available colors, this feature is useful when a
request is made for a large number (over 96) of contours.
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v.  Contour and Line Thickness allows you to toggle between thick and thin for contour
lines, streamlines and barbs.

Options =

* Labels On

Labels Off

Label Placement

Label 5ize

Contour Units

Black contours aver shaded

Contour and Line Thickness

Figure 32. Options menu options in the Parameter Options dialog.

When there are two or more parameters selected for the chart, you have several
options for displaying the legends. There is one important consideration if you elect
to have at least one of the color legends turned off. The parameter that has the color
legend turned off will have a colored tag next to its full name located in the lower left
corner of the chart. The color of this tag indicates the average data value for that
parameter with respect to the color scheme that has been selected.

d. Interval Settings: This allows you to set the interval between the contour lines. The data

c.

contour levels can be set using arrow buttons (<, >, <<, or >>). The single arrow buttons
(< or >) adjust the displayed value by the value of the contour interval. The double arrow
buttons (<< or >>) adjust the displayed value by twice the value of the interval. The
numerical values for these fields may also be set manually by clicking in the field box.
The allowable values will be restricted to one half (lower bound) to two times (upper
bound) of the default value that is present when you first bring up the Parameter Options
dialog.

1. Maximum: This control allows you to set the highest contour line value that will be
displayed.

ii.  Minimum: This control allows you to set the lowest contour line value that will be

displayed.

Flag Thresholds: These settings allow you to highlight data values of special concern
using indicator colors. These values can be set using the same means as with the interval
settings (arrows or manual entry). You can select Caution and Warning colors to be any
of the following: black, white, red, green, blue, cyan, magenta, yellow, orange, purple,
yellow/green, med. blue, dark yellow, aqua, dark purple, or gray.

i.  Caution: This control allows you to set the level, above or below, which data are
colored to signal a caution condition.

ii.  Warning: This control allows you to set the level, above or below, which data are
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colored to signal a warning condition. If the Warning level is greater than the
caution level, all data values between the caution level and the warning level will be
the color selected for Caution. All data values greater than the warning level will be
the color selected for Warning. If the Caution level equals the Warning level, neither
color will appear.

When Warning level is /ess than the caution level all data values between the
& caution level and the warning level will be the color selected for Caution. All
data values less than the warning level will be the color selected for Warning.

. Vector Plot Settings

The vector data (e.g., winds or currents) display options allow you to modify 1) vector
representation, 2) grid spacing, and 3) stream density.

a.

1.

11.

1il.

a.

b.

Vector representation: These radio buttons are grouped to allow you to select one of the
following: vector barbs, vector arrows, or streamlines.

Vector Barbs: Depicts vectors as a line showing the wind direction with barbs at the
“from” end showing the wind speed (one barb = 10 knots, one half-barb = 5 knots,
one “flag” = 50 knots). This is the most common convention used by meteorologists.

Vector Arrows: displays the winds as arrows, with a point on the “to” end. The length
of the arrow is proportional to the wind speed.

Streamlines: displays the winds as streamlines that indicate the direction of air flow.
Streamlines are colored according to magnitude unless a single color is chosen.

Barb Size: This setting allows you to control the relative size of wind barbs. The final
size is an automatic function of grid thinning, the model grid spacing and domain size.

Grid Thinning: This setting allows you to reduce the number of points displayed in order
to make the display more readable. The higher the value you set, the fewer points are
displayed.

Stream Density: This control allows you to adjust the density of the streamline display.
Higher numbers yield more streamlines.

. Line Plot Settings

Style: This set of radio buttons allows you to select the line style that will be used to plot
the contour lines or single line plots for this parameter. The optional styles include: Solid
(default), Dotted, Long Dash, and Short Dash.

Marker: This set of radio buttons allows you to select the marker that is displayed at each
data point in single line plots. The default value (None) turns off marking of the data
points. With any other selection, the selected marker will be plotted at each data point.
The other selections include: Open Dot, Open Box, Cross, Solid Dot, and Solid Box.
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Control Buttons
a. Help: Displays this document.
b. OK: Accepts all values currently displayed and closes the dialog.

c. Cancel: Closes the dialog without making any changes to the values that were set
previously.

3.4 ZOOM FUNCTIONS

You can magnify a particular area in two ways:

1.

Use the middle mouse button to draw a box around the area you want the display to cover.
When you let go of the mouse button, the map is redrawn to include only the area you
selected. Unzoom and Zoom Out buttons appear at the top right.

Click once with the middle mouse button at a desired center point on the map. This method
magnifies the display two times and centers it on the point you clicked. Unzoom and Zoom
Out buttons appear at the top right. You can zoom as many times as you like using either
method. The Zoom Out button always returns the screen to its original area, not to the
previous zoom level. The Unzoom button will allow you to back out of your zoom, if you
have zoomed in multiple times.

Custom charts that are saved with a zoomed view will retain the zoom on the web
page charts.

3.5 SAVING YOUR WORK

There are two ways to save your work in IPVS CHARTS:

1.

To save the current sequence as a set of images, click on the File menu and select either the
Save Image or Save Image As option. The Save Image option saves the images in the
current format with default file names. The Save Image As option presents a Save File
dialog that allows you to enter the file name(s) and select the data type. The selected data
type will set the default format for the current save as well as future saves.

The Save File dialog also lets you change directories. However, it is recommended
that you use the default directory so that IPVS_CHARTS will be able to find the files
you have saved.

To make a chart sequence, click on the Automate menu and select either Save Product or
Save Product As from the drop down menu. This automatically generates a new set of
images during each update cycle. The Save Product option saves the sequence definitions
with the current chart name. The Save Product As option presents a Save File dialog that
allows you to enter the chart name(s).
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The Save Image As type-in name must not have a period if the file extension (e.g., “gif”) is
omitted. If the file extension is entered, only one period is allowed (e.g., slpr.gif). Any
additional periods will automatically be converted to hyphens.
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4 DEFINITIONS OF TERMS

COAMPS
FNMOC

GIF

IPVS
NOGAPS
PDF

PNG

COAMPS-0OS

Coupled Ocean/Atmosphere Mesoscale Prediction System

Fleet Numerical Meteorology and Oceanography Center

Graphics Interchange Format. One of several image formats supported by

IPVS _CHARTS. Other image formats include: PNG.
Integrated Portable Visualization System
Navy Operational Global Atmospheric Prediction System

Portable Document Format.

Portable Network Graphics. One of several image formats supported by

IPVS CHARTS. Other image formats include: GIF.

Coupled Ocean/Atmosphere Mesoscale Prediction System - On Scene
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